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UV-VIS UV-1800 de shimadzu

Resumen

El Departamento de Ciencias Básicas de la Universidad EAN 
cuenta con un equipo de espectrofotometría UV-VIS UV-1800 de 

la casa comercial Shimadzu de doble haz, para el análisis de una gran 
variedad de analitos de origen tanto orgánico (compuestos orgánicos 
conjugados) como inorgánico (iones metálicos de transición), que 
tienen absorción de radiación en estas longitudes de onda, desde el 
UV lejano al infrarrojo en el rango de 120nm y 1100nm. 

El espectrofotómetro UV-1800 permite realizar la caracterización de 
compuestos (acercamiento a la identificación de grupos funcionales) 
y un análisis cuantitativo de cromóforos con una sensibilidad de 
ppm para estar a la vanguardia de la tecnología y del conocimiento 
investigativo en lo que a técnicas de análisis instrumental se refiere. 

Palabras clave 

Espectrofotometría, análisis instrumental, UV-VIS, análisis 
cuantitativo.
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Introducción

Es conocida la naturaleza dual que posee la tanto con propiedades 
corpusculares como ondulatorias. De esta forma algunos 

fenómenos es posible interpretarlos a la luz del modelo ondulatorio 
de la luz, así como otros pueden ser estudiados desde el modelo de la 
luz como un conjunto de partículas elementales llamadas fotones. Las 
propiedades básicas de la luz son su longitud de onda (distancia entre 
picos adyacentes (o valles), y se designa frecuentemente en nanómetros) 
y su frecuencia (es el número de ciclos de onda que pasan por un punto 
fijo por unidad de tiempo; y se mide en ciclos por segundo o Hertz - 
Hz).  

La luz visible representa apenas una pequeña porción del espectro 
electromagnético, que abarca desde longitudes de onda muy cortas 
(rayos gamma y rayos X) hasta longitudes de onda muy largas 
(microondas y ondas de radio). La figura 1 muestra las regiones más 
representativas del espectro.

        
Figura 1.  Espectro electromagnético. Resaltado en el recuadro, indica el rango 
                de adquisición el equipo UV-1800.

Fuente. Adaptada de https://www2.chemistry.msu.edu/faculty/reusch/
virttxtjml/spectrpy/uv-vis/spectrum.htm.
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Cuando un haz de luz blanca pasa a través de una sustancia 
coloreada, una porción de las longitudes de este rango es absorbida, 
mientras que el restante conjunto de longitudes de onda es reflejado; 
fenómeno que origina el color de los cuerpos, y en el que se basa la 
espectrofotometría de absorción UV-VIS.

La espectrofotometría de absorción UV-VIS se encarga de medir 
la atenuación de un haz de luz después de su paso a través de una 
muestra. Esta técnica es comúnmente usada para la detección de 
grupos funcionales, detección de impurezas, análisis cualitativo y 
cuantitativo de analitos, medicamentos con grupos cromofóros entre 
otras aplicaciones.

El principio básico de la técnica de UV-VIS es la absorción de 
radiación de una frecuencia determinada en el rango de longitudes 
de onda de UV-VIS, realizada por una molécula para producir una 
transición de un nivel de baja energía a un nivel de mayor energía. 

En términos generales, la energía total de una molécula (ET) es la 
sumatoria de su energía electrónica (EE), su energía vibracional (EV) 
y su energía Rotacional (ER). 

ET= EE + EV + ER

La energía de la radiación en el rango de longitud de onda del 
visible (38.1 a 71.5 Kcal/mol) es menor que en el rango del ultravioleta 
(UV) (143 a 71.5 kcal/mol) (Gilbert & Martín, 2011). En este rango 
de valores de energía se verá qué tipo de transiciones son posibles 
en la molécula, ya que la magnitud de la energía requerida por la 
molécula decrece en el siguiente orden: EE > EV > ER, de tal forma 
que las transiciones posibles en la molécula son de tipo vibracional, 
rotacional y hasta electrónica dependiendo de la región del espectro 
que incide sobre la misma, como se esquematiza en la figura 2:
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Figura 2. Diagrama de los niveles de energía de un átomo o molécula. 

Fuente. Adaptada de Jang, 2017.

En la anterior figura, se indican con flechas los cambios que se 
producen por absorción de radiación infrarroja (IR), visible (VIS) y 
ultravioleta (UV).

El equipo UV-1800 disponible en nuestros laboratorios puede 
realizar lecturas entre los 120nm y 1100nm. Este rango de radiación 
cubre el espectro UV cercano y lejano, el espectro VIS y parte del 
infrarrojo cercano (NIR), como se representó en la figura 2, por 
tanto, el tipo de transiciones moleculares que podemos esperar son 
electrónicas y vibracionales, que al combinarse generan bandas anchas 
características de los espectros UV-VIS, por la combinación de los 
diferentes tipos de transiciones específicas para cada compuesto o 
mezcla de compuestos, en el espectro que se registra como resultado 
de un barrido en el rango de análisis del equipo UV-1800.
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En este orden de ideas, al adquirir un espectro en el rango de lectura 
del UV-1800, el usuario obtiene como resultado el conjunto de bandas 
de absorción de todas las posibles transiciones de su(s) compuesto(s), 
que serán acordes a las posibles transiciones de los grupos funcionales 
de su molécula; como metodología de caracterización química de un 
material (identificación de grupos funcionales). 

La absorbancia (medida de la capacidad de una sustancia de 
absorber luz de una determinada longitud de onda. La absorbancia 
es igual al logaritmo del inverso de la transmitancia) de una muestra 
es proporcional al número de moléculas absorbentes en el haz de luz 
del espectrómetro (concentración molar de analito), acorde a la ley 
de Lambert-Beer; de modo que el equipo UV-1800 permite realizar 
medidas cuantitativas de un analito, partiendo de la construcción 
de una curva de calibración para interpolar la concentración de la 
muestra, desde la relación matemática de las concentraciones de los 
estándares conocidos con una sensibilidad en el UV-1800 hasta el 
rango de ppm.
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1.1 Especificaciones generales del
      Instrumento

Las principales partes de un espectrofotómetro son tres, el sistema 
de iluminación, el sistema monocromador y el sistema de detección 
y registro.

Tabla 1. Especificaciones generales del instrumento.

Dimensiones 450 (ancho) x 490 (profundidad) x 270 
(altura) mm

Peso 15 kg

Fuente de luz Lámpara de tungsteno y lámpara de deuterio. 
Vida útil: 2000 horas

Intervalo espectral 190,0 ~ 1100,0 nm

Temperatura de operación 15°C – 35°C

Ancho de banda espectral 1nm (190 to 1100nm)

Indicación de la longitud de onda En incrementos de 0.1-nm

Fijación de la longitud de onda En incrementos de 0.1-nm (incrementos de 
1-nm al establecer un intervalo de barrido)

Exactitud espectral (para 
validación del equipo, en correcto 
funcionamiento del sistema óptico)

±0.1nm @ 656.1nm D2 ±0.3nm (190 to 
1100nm)

Repetitividad espectral ±0.1nm

La luz espuria o errática: es toda luz que 
llega al detector sin haber atravesado 
la muestra cuya absorbancia queremos 
medir.

Menos de 0.02 % usando NaI a 220nm, 
NaNO2 a 340nm menos de 1.0 % usando 
KCl a 198nm

Sistema fotométrico Doble haz

1.Operaciones básicas 
con el instrumento
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Intervalo fotométrico de medida Absorbancia: -4 a 4 Abs. Transmitancia: 0 % 
a 400 %

Exactitud fotométrica ±0.002 Abs (0.5Abs) ±0.004 Abs (1.0Abs) 
±0.006 Abs (2.0Abs)

Repetitividad fotométrica Menos de ±0.001 Abs (0.5 Abs), menos de 
±0.001 Abs (1 Abs), menos de ±0.003, Abs 
(2.0 Abs)

Estabilidad de la línea de base Menos de 0.0003 Abs/hora a 700nm (después 
de una hora de encendida la fuente de luz)

Nivel de ruido 0.05 valor RMS a 700nm

Software UV-PROBE
	
Fuente. Shimadzu, 2014. 

1.2  Consideraciones antes de encender el 
        instrumento

Verifique que el compartimiento de las celdas se encuentre desocupado 
cuando encienda el interruptor del instrumento. Si hay un objeto 
obstruyendo el paso de la luz en el chequeo inicial generará el error 
“NG” en energía de la lámpara por baja intensidad de la luz incidente 
en el detector (SHIMATDZU.UV-1800, 2013).

1.3  Operación básica de encendido

A continuación se describe secuencialmente cómo encender el equipo 
y acondicionarlo para realizar un análisis, estos pueden ser realizados 
stand alone (sección 5) o a través del software UV-PROBE (sección 6).

A. El encendido del instrumento se realiza directamente en el 
interruptor, ubicado en la parte inferior derecha del equipo. 

Tabla 1. Especificaciones generales del instrumento (Continuación)
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Figura 3. Imagen Externa Espectrofotímetro UV-1800.

Fuente. LabCommerce, 2017.

B. Cuando el instrumento es encendido (ON), el UV-1800 comenzará 
de manera automática la ejecución de chequeos de rutina e 
inicialización. Una vez terminado el autochequeo el equipo 
solicita identificar el usuario y la contraseña; ingrese con el usuario 
Administrador, el password es nulo, ingrese con Enter desde el 
teclado del UV-1800. Una vez terminado el chequeo inicial se 
observa la siguiente pantalla del UV-1800. 

Nota. Para garantizar estabilidad en las lecturas realizadas, se 
recomienda encender el instrumento como mínimo 30 minutos antes 
de realizar las lecturas. 
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Figura 4. Esquema pantalla operación modo Stand alone.

 

Fuente. Shimadzu, 2014.

La figura muestra la relación entre el UV-1800 y el teclado. Los 
modos y configuraciones de cada pantalla se seleccionan con los 
números de 0 a 9, presionar Enter o las teclas F1-F4.

1.3.1 Corrección línea base

La corrección de la línea base se realiza sin celdas en el equipo y en el 
rango de longitud de onda seleccionado, afecta a todas las subsecuentes 
lecturas con el mismo rango. La corrección de la línea base asegura un 
punto de referencia antes de iniciar cualquier colección de datos, por 
ello una vez terminada la corrección de línea base la información es 
almacenada en el historial del instrumento, incluyendo analista, fecha 
y será aplicado para todos los subsecuentes análisis.

A. En la pantalla inicial con el teclado digite 2 para seleccionar el 
módulo espectro (Spectrum) y Enter. 
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B. La ventana que observará se muestra en la imagen a la derecha. 
Seleccione 2 para establecer el rango de longitud de onda en el que 
desea analizar, ingrese 1100 con el teclado numérico y dé Enter, 
digite 190 y de nuevo Enter. Este corresponde al rango total de 
análisis del equipo. 

Figura 5. Esquema pantalla operación modo Stand alone. Modulo spectrum. 

Fuente. Shimadzu, 2014. 

C. Terminada la configuración verifique que no se encuentre ninguna 
celda en los compartimientos. Posteriormente realice la corrección 
de linea base presionando la tecla          

1.3.2 Preparación de la muestra en la celda 
        de lectura

En general todos los espectrofotómetros UV-VIS son instrumentos 
para la medición de muestras en solución (mezclas homogéneas), 
por tanto, es indispensable que si su muestra contiene partículas 
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de un tamaño mayor al de una solución (colides, dispersiones, 
espumas), es necesario realizar un tratamiento previo como filtración 
o centrifugación, ya que partículas de mayor tamaño resultan en 
absorbancias altas que no corresponden a la absorción por excitación 
de la muestra, sino por obstrucción del paso de luz (cuerpos opacos).

A.	Asegúrese que las celdas de cuarzo estén completamente limpias 
antes de adicionar su solución.

B.	En la primera celda adicione el solvente (blanco) dejando 1 cm 
abajo del borde, se recomienda realizar una adición de solvente 
a la celda para purga, descarte y adicione nuevamente disolvente 
evitando que queden burbujas al interior de la solución, ya que la 
presencia de aire afecta la medición.

Figura 6. Macro cuvette.

Fuente. https://www.brand.deg

C.	Ubique la tapa de la celda en la parte superior de la misma. Limpie 
con papel de arroz el exterior de la celda. 

D.	Introduzca la celda con el solvente en el compartimiento superior 
de referencia. Para ubicar la celda en el equipo oriente la sección 
opaca de la celda hacia su frente, para permitir el correcto paso del 
haz de luz a través de la celda con la solución. 
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E.	Adicione la solución a medir en la otra celda de cuarzo, repita el 
mismo procedimiento que para la celda de referencia. Ubique la 
celda con la muestra en el compartimiento inferior del equipo, 
como lo muestra la imagen. 

Figura 7. Compartimientos para muestra UV-1800. G. 

Fuente. Adaptada de https://article.wn.com/view/2016/09/30/FY2015_
Slavery_and_Human_Trafficking_Statement_Shimadzu_Corp/

F.	 Una vez ubicadas las celdas, cierre el compartimiento del equipo 
para realizar la medición.

G.	Para operar el instrumento en modo stand alone continúe en la 
sección 3. Si se va a operar el equipo conectado al software UV-
Probe continúe en la sección 5.

Figura 8. Esquema pantalla menú operación stand alone. 

Fuente. Shimadzu, 2014.
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2.1  Lectura en modo fotométrico 
      (photometric)

A. En la pantalla en la que se encuentra oprima Return para regresar 
al menú inicial, con el teclado digite 1 para seleccionar el módulo 
fotométrico (photometric) y dé Enter.

	 El UV-1800 en modo fotométrico permite realizar una medición a 
una única longitud de onda (item 1), o podemos tener la posibilidad 
de realizar una medición hasta en 8 diferentes longitudes de onda 
(item 2). 

B. Seleccione item 1 y Enter Inmediatamente se encontrará con la 
vetana de la imagen.

Figura 9. Esquema pantalla menú operación stand alone método fotométrico. 

Fuente. Shimadzu, 2014.

2.Operaciones stand 
alone en el UV-1800 
(Shimadzu.UV-
1800,2013)
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C. Cambie el valor de la longitud de onda con la tecla 

D. Ubique la celda con la solución de referencia (blanco) en 
el compartimiento superior, y la celda con el analito en el 
compartimiento inferior como se describe en la sección 3.3. 

E. El valor que muestra el monitor corresponde a la absorbancia de su 
muestra, para obtener el valor de transmitancia  	        presione y

     seleccione con las flechas % T. 

2.2  Lectura en modo espectro (spectrum)

A. En la pantalla inicial con el teclado seleccione 2 para seleccionar el 
módulo espectro (Spectrum) y Enter. 

B. La ventana que observará contiene los mismos campos que el 
módulo Spectrum en el software UVProve (sección 5). Presione 1 
en el teclado con las flechas seleccione las unidades en las que desea 
realizar su medición: absorbancia 0 %, transmitancia y Enter.

Figura 10. Esquema pantalla menú operación stand alone método espetro. 

Fuente. Shimadzu, 2014.

GOTO
WL

F1
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C. Seleccione 2 para establecer el rango de longitud de onda en el que 
desea analizar y Enter. 

D. Si desea realizar un ajuste de la escala del eje Y antes de iniciar la 
adquisición, puede ajustar el máximo y mínimo seleccionando la 
opción 3 y Enter, por ejemplo: valor mín 0.000A – 1.000A y Enter.

E. Seleccione 4 y establezcla el tiempo de acumulación (tiempo de 
espera entre una lectura y otra) la opción Fast toma datos cada 
0.05s, Medium cada 0.2s, Slow cada 0.5s y Very slow cada 2.0s. El 
parámetro por defecto es Medium. 

F. Seleccione 5 para configurar el intervalo entre una medida y otra 
durante el escaneo del rango de longitud de onda. Auto: configura 
el intervalo dependiento del rango de lectura de manera automática, 
0.05 toma datos cada 0.05nm y los demás valores opcionales de 
igual manera. Una vez seleccionado el modo de configuración 
deseado presione Enter.

G. Seleccione 6 para configurar el número de scan para cada punto 
(de 1 a 99 veces).

H Seleccione 7 y configure la forma en la cual desea visualizar el 
espectro. Sequential: en la pantalla solo será visualizado el espectro 
en adquisición y por cada adquisición se actualiza. Overlay: la 
pantalla no se actualiza, comenzará a ver el espectro en adquisición 
desde la izquierda sobre los adquiridos anteriormente.

Actualmente la opción 8 siempre permanecerá en off, ya que no se 
encuentra conectado el accesorio de impresión.

I. Ubique las celdas de referencia y la muestra con el analito en los 
compartimientos superior e inferior, como se describe en la sección 
4.3, cierre la tapa del equipo para iniciar la adquisición de datos, 
presione la tecla START

STOP
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j. Una vez termine la adquisición obtendrá una pantalla como se 
evidencia en la imagen. Si la escala no le permite ver la totalidad 
del espectro presione Return para ajustar el zoom y seleccione 
AutoScal con la tecla F3.

Figura 11. Esquema pantalla resultado adquisición espectro en modo stand alone. 

Fuente. Shimadzu, 2014.

k. Si desea ubicarse en una coodenada del espectro movilice la línea 
de lectura con las flechas hacia la derecha y hacia la izquierda. Las 
coordenadas Abs y longitud de onda le aparecerán resaltadas en la 
parte inferior del espectro. Almacene los datos de la adquisición en 
su memoria USB, que puede conectar presionando F3 (LoadCurv). 

Figura 12. Imagen externa UV-1800. 

Fuente. LabCommerce, 2017
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El software disponible para el funcionamiento del equipo UV-
1800 Shimadzu es el UVProve, un software propietario de la casa 

fabricante Shimadzu. Permite colectar, analizar y generar reportes de 
manera simple e intuitiva.

El software incluye cuatro componentes básicos:
w	 El módulo Spectrum, usado para escanear y analizar analitos en un 

rango determinado de longitudes de onda.
w	 El módulo Kinetics, usado para realizar mediciones en diferentes 

intervalos de tiempo; es un método útil en la determinacion de 
cinéticas de reaccion Michaelis-Menten, en las que se describe la 
velocidad de reacción por catálisis enzimática. 

w	 El módulo photometric para análisis cuantitativo de analitos. Con 
este paquete es posible realizar la medición de un único valor de 
absorbancia (o % T) a una o más (hasta 8) longitudes de onda 
especificadas por el usuario, así como la construcción de curvas de 
calibración para el análisis cuantitativo de un analito basado en la 
ley de Lambert-bee.

w	 Generador de reportes. 

3.1 Procedimiento para la operación del 	          	
      UV-1800 con el software UV-PROVE

A. Para iniciar la conexión el UV-Probe al PC verifique la conexión 
USB del UV-1800 al equipo de cómputo desde el cual operará el 
equipo, el cual deberá tener instalado y configurado el software 
UVProbe.  Inicie el software, como se muestra a continuación:

3.Operación del UV-1800 
con el software UV-
Probe (Shimadzu. 
UV-Priobe, 2013)
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Figura 13. Imagen ventana inicial software UVProbe.

 

Fuente. Shimadzu U.-P. , 2014. 

B. Verifique que el espectrofotómetro se encuentre conectado a su PC 
en la barra de herramientas inferior. Si está conectado los botones 
los observará activos y el último ícono de la derecha será Disconnect 
(imagen arriba). En caso contrario, haga clic en Connect en la 
barra de herramientas inferior.

3.2 Módulo Spectrum

El objeto del módulo Spectrum es el control del espectrofotómetro 
para la adquisición de un barrido en un rango de longitudes de onda 
de la muestra de análisis.

El módulo incluye 3 paneles y una barra de herramientas (imagen 
a la derecha):

En el panel de operación visualiza la información colectada, las 
funciones de manipulación como Data Print, áreas de los picos y 
picos seleccionados. En el panel de método visualiza la información 
del método de colección de datos actual. En el panel de gráfico se 
visualizan los gráficos activos, superpuestos con anteriores scan o 
listados uno tras otro.

A ícono en el escritorio para iniciar 
UVProbe.

B Pantalla inicial de UVProbe, 
en la barra de herramientas de la 
parte inferior encontrará el ícono 
para solicitar la conexión al equipo 
desde el software una vez se halla 
encendido el UV-1800.
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Figura 14. Imagen ventana inicial software UVProbe para operación
                  en modo espectro.

Fuente. Shimadzu U.-P. , 2014. 

El procedimiento general para la construcción de un espectro en 
un rango de longitud determinada se muestra a continuación:

Figura 15. Diagrama procedimiento para adquisición en modo 
                  espectro usando UVprobe. 
 

Fuente. Elaboración propia. 

Crear nuevo método de colección de datos 
(Parámetros)

Guardar método de 
medida

Corrección línea base

Preparación de la muestra en la celda

Colección de datos del espectro

Guardar datos
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3.2.1 Creación nuevo método de colección de datos

A.	Para iniciar el módulo Spectrum ubicado en la barra de herramientas 
superior, dé clic en el ícono  

B.	De la barra de herramientas superior, seleccione Edit > Method, o 
haga clic en el ícono Método para desplegar el siguiente cuadro de 
diálogo:

Figura 16. Barra de herramientas principal UVprobe en modo espectro.

Fuente. Shimadzu U.-P. , 2014. 

C.	En la pestaña Measurement, configure el rango de longitud de 
onda en el que desea analizar su muestra, en la opción Wavelength 
range (nm) por ejemplo si su rango de interés es: (600nm y 450nm) 
ingrese 600 en el campo Start y 450 en el campo End.

D.	Seleccione en el campo velocidad de barrido (Scan Speed) medio 
para una adquisición cada 1nm; si desea mayor resolución 
disminuya la velocidad de scan hasta 0.1nm.

E.	En el campo de Scan Mode seleccione single para realizar una única 
lectura por punto en el rango de longitud de onda seleccionado.
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Figura 17. Menú configuración  parámetros de medición modo espectro.

Fuente. Shimadzu U.-P. , 2014. 

F. En la pestaña Instrument Parameter de la misma ventana (imagen 
a la izquierda), seleccione Absorbancia en la lista de formas de 
medida (Measuring Mode).

G. Clic en OK para enviar los parámetros al espectrómetro. Cerciórese 
de la configuración en el espectrofotómetro.

Figura 18. Menú configuración  parámetros del instrumento modo espectro.

Fuente. Shimadzu U.-P. , 2014. 
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3.2.2 Guardar método de medida

Guarde el método como un archivo .smd para ello:

Figura 19. Barra de herramientas principal uv probe  parámetros 
                 de medición modo. 

Fuente. Shimadzu U.-P. , 2014. 

A.	Seleccione de la barra de herramientas superior File > Save as.
B.	En el campo File name, ingrese el nombre del archivo, por ejemplo: 

Metodo_Espectro_600-450.
C.	En la lista Save as type, dé clic en Method file (*.smd), acto seguido 

clic en Save. 

3.2.3 Corrección línea base

La corrección de la línea base se realiza sin celdas en el equipo, y en el 
rango de longitud de onda seleccionado afecta a todas las subsecuentes 
lecturas con el mismo rango. Si la corrección de línea base se realizó 
con el equipo operando en modo Stand Alone (Sección 4.2) no es 
necesario realizarla nuevamente usando el software. Si no ha realizado 
la corrección puede hacerla usando UV-Probe, como se indica a 
continuación:

A.	Seleccione Window>Spectrum para abrir el módulo Spectrum.
B.	Clic sobre Connect en la barra de herramientas inferior para 

conectar el software al UV-1800.
C.	Cuando los parámetros de la línea base aparezcan en el panel de 

método entre 700 como Start y 300 como End, modifíquelos de 
acuerdo al rango de longitud de onda de su interés. Dé clic en OK. 
Verifique la lectura en la ventana del espectrofotómetro.
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D.	Cuando el scan ha finalizado, dé clic en la pestaña Instrument 
History y verifique que la corrección de línea base haya sido 
efectuada.

Figura 20. Ventana UVProbe de procesos.

Fuente. Shimadzu U.-P. , 2014. 

3.2.4 Colección de datos para el espectro

A.	Para asegurar que toda la información colectada es visualizada en 
el gráfico, dé clic derecho con el mouse y seleccione Auto Scale.

Figura 21. Menú configuración de escala UVProbe para modo espectro.

 

Fuente. Shimadzu U.-P. , 2014. 

B.	Dé clic en Start en la barra inferior. En el cuadro emergente New 
Data Set indique el nombre del espectro PE: Didymiun en el campo 
File y el nombre de la información de salida PE: Data 1, y dé clic 
en OK para iniciar la medición.
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Figura 22. Ventana UVProbe almacenar método.

 

Fuente. Shimadzu U.-P. , 2014. 

3.2.5 Almacenamiento de la información

Para este punto del análisis la información ha sido colectada y 
nombrada, la información ha sido almacenada únicamente en la 
memoria; pero no ha sido almacenada en el disco. Si el software es 
cerrado en este momento la información se perderá. Para preservar 
la información es necesario guardar cada información en un archivo 
que incluirá: tabla de Peak Area, tabla de Point Pick, tabla de Peak 
Pick, información del método, resumen de la información e historial 
de la información. 

A.	Seleccione File > Save as.

B.	Seleccione la ruta apropiada para el directorio en el campo superior 
de la ventana de diálogo.

C.	Ingrese el nombre del archivo, por ejemplo: Diymium.

D.	Seleccione .spc in la lista Save as type.

E.	Clic en Save.

 
Para editar reportes y manipulación del espectro diríjase a la sección 
5.3: generación de reportes.
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3.3  Módulo photometric
El objetivo básico del módulo fotométrico es determinar la 
concentración de un analito en una muestra. Al realizar medidas de 
absorbancia (o transmitancia) de soluciones estándar de diferente 
concentración con el espectrofotómetro el software nos sirve de 
herramienta para la creación de una curva de calibración, la cual puede 
ser usada para calcular la concentración de muestras desconocidas, 
interpolando la relación matemática calculada.

El módulo incluye cuatro paneles importantes: tabla de estándares, 
curva de estándares, tabla de muestras, gráfica de muestras, cada panel 
tiene solamente una función a visualizar, con excepción de la tabla de 
muestras que incluye los estándares. 

Figura 23. Esquema de ventanas UVProbe para método cuantitativo.

 

Fuente. Shimadzu U.-P. , 2014. 

Para ingresar al módulo photometric            seleccione el ícono de 
la barra de herramientas superior:

Figura 24. Barra de herramientas UBProbe principal para modo fotométrico.

Fuente. Shimadzu U.-P. , 2014. 
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El procedimiento de creación de una curva de calibración y lectura 
de una o varias muestras desconocidas se esquematiza en el siguiente 
diagrama de flujo:

Figura 25. Diagrama procedimiento para adquición en modo fotométrico en 
                  software UVProbe.

 

Fuente. Elaboración propia. 

3.3.1 Creación nuevo método de colección de datos 
         (parámetros adquisición curva calibración)

A.	En la barra de herramientas superior seleccione File > New.
B.	Seleccione Edit > Method. Se abrirá la ventana emergente 

Photometric Method Wizard.

Creación nuevo método de colección de datos
(Parámetros adquisición Curva Calibración)

Guardar método

Información archivo (Curva de calibración)

Información - (Tabla de estándares)

Lecrura de los estándares

Guardar resultados tabla de estándares

Lectura muestra de análisis

Guardar información del análisis

Medición muestra desconocida

}
}
}

Creación del 
método

Medición de 
estándares

Medición 
muestra 

desconocida
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C.	En el campo Wavelength (nm) ingrese la(s) longitud(es) de onda en 
las que desea realizar la(s) curvas de calibración; por ejemplo 530, 
para incluir esta longitud en las entradas (Entries) haga clic en el 
ícono Add. Comenzarán a aparecer las longitudes de onda en el 
recuadro Entries. Proceda con la segunda longitud de onda, por 
ejemplo 550 y dé clic en Add.

Figura 26. Ventana configuración parámetros del instrumento UVProbe en 
                   modo fotométrico.

Fuente. Shimadzu U.-P. , 2014. 

D.	Dé clic en Siguiente para configurar los parámetros que se describen 
a continuación:

E.	En el campo Type box, seleccione Multi Point para especificar que 
la curva de calibración será construida para dos puntos diferentes 
(530nm y 550nm según el ejemplo). Si se va a realizar la curva en 
una única longitud de onda seleccione Single Point.

F.	 En el campo Formula seleccione Ratio.
G.	En el campo WL1 especifique la primera longitud de onda (por 

ejemplo 530) y en el campo WL2 la segunda (550). Si desea construir 
la curva en una única longitud de onda seleccione Single point. Y 
en Formula Fixed Wavelength.
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Figura 27. Ventana configuración parámetros para cuantificación UVProbe 
                  en modo fotométrico.

Fuente. Shimadzu U.-P. , 2014. 

H.	Verifique que en el campo Columna Name sea Result. Para cada 
muestra que sea leída por el equipo, el resultado indicará la 
absorbancia leída a 530nm, dividido por la absorbancia leída a 
550nm. 

I.	 En el campo Order Curve seleccione 1 para una relación matemática 
lineal de la curva de calibración. Dé clic en Siguiente. Encontrará 
esta ventana:

Figura 28. Ventana configuración parámetros de medición del estandar para 
                   cuantificación UVProbe en modo fotométrico.

Fuente. Shimadzu U.-P. , 2014. 
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J.	 Seleccione el método de adquisición en el campo Data Acquired 
by desde el equipo, escogiendo la opción Instrument. Dé clic en 
Siguiente.

K.	 Aparecerá la ventana de parámetros de medición para muestras 
desconocidas, la cual se puede configurar. Elija el método de 
adquisición en el campo Data Acquired By desde el equipo, 
seleccione la opción Instrument. Dé clic en Siguiente.

Figura 29. Ventana configuración parámetros de medición para la muestra en 
                   método de  cuantificación UVProbe en modo fotométrico.

Fuente. Shimadzu U.-P. , 2014.

L.	 Una vez configurados los parámetros de medición, encontrará 
la ventana para configurar las propiedades del archivo para 
almacenamiento. En el campo Filename indique la ruta en la 
que el archivo del método y los resultados serán almacenados, 
por defecto es almacenado en la carpeta Data del archivo del 
software, el nombre del archivo corresponderá a la fecha_hora de 
adquisición. La extensión es .pho. 

M.	Para terminar dé clic en Finalizar.
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Figura 30. Ventana para almacenamiento de método cuantitativo en UVProbe. 

Fuente. Shimadzu U.-P. , 2014. 

N.	 Aparecerá una ventana emergente para especificar los parámetros 
de la medición fotométrica.

O.	 Seleccione la pestaña Parameter tab.
P.	 Seleccione la pestaña de Instrument Parameters.
Q.	 Seleccione en el campo Measuring mode Absorbance.
R.	 En el campo de Slit Width(nm) seleccione 2.0. 
S.	 Se recomienda dejar los demás parámetros por defecto. 
T.	 En la pestaña Wavelengths las longitudes de onda fueron las 

ingresadas, para el ejemplo WL530, WL550 y Result.
U.	 Dé clic en Close.
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Figura 31. Configuración de parámetros instrumentales método fotométrico 
                  para cuantificación.

Fuente. Shimadzu U.-P. , 2014. 

3.3.2 Guardar método

Este paso es importante si a futuro se desea realizar una colección de 
datos usando el mismo método que acaba de configurar. Este archivo 
será almacenado con extensión *.pmd.

Figura 32. Menú emergente en File sobre la barra de herramientas 
                  principal UVProbe. 
 

Fuente. Shimadzu U.-P. , 2014. 

A.	Seleccione File > Save As. Verifique la ruta de almacenamiento del 
archivo en el campo Data (directory) en la ventana de Save.

B.	En el campo File Name, ingrese el nombre el archivo, por ejemplo 
PhotoMeth.

C.	En el campo Save As Type, seleccione del listado desplegable 
Methods (*.pmd) y dé clic en Save. 
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Figura 33. Ventana para almacenamiento de archivo de configuración para el 
                   método cuantitativo creado en UVProbe. 

Fuente. Shimadzu U.-P. , 2014. 

3.3.3 Medición de estándares

La configuración de información como nombre de archivo para la 
realización de la adquisición. Si existe un método creado (*.pmd) 
puede llamarlo para la medición. 

Figura 34. Menú emergente para abrir archivos creados sobre la barra de 
                  herramientas principal UVProbe. 

 

Fuente. Shimadzu U.-P. , 2014.

A.	Seleccione File > New para salir del método actual.
B.	Seleccione File > Open.
C.	Seleccione en el campo File Type > Measurement File (*.pmd=. de 

doble click en el método que creó en el paso anterior PhotoMetric (o el 
que dese usar para su medición que haya sido creado con anticipación).

D.	Dé clic en Abrir.



39
Aplicaciones y generalidades de un espectrofotómetro 

UV-VIS UV-1800 de shimadzu

Figura 35. Ventana para apertura de archivos UVProbe.

Fuente. Shimadzu U.-P. , 2014.

E.	Aparecerá la ventana File Property. Ingrese en el campo File 
Name el nombre del archivo de adquisición de salida por ejemplo 
Photo 1.pho. puede ingresar Título del análisis comentarios en 
los campos indicados de esta ventana o puede saltar este paso. Y 
finalizar dando click en OK.

3.3.4 Información, tabla de estándares

Una tabla de estándares (Standard table) es una tabla de resultados 
(absorbancia, transmitancia, energía o reflectancia) adquiridos para 
concentraciones conocidas de un analito a una o varias longitudes 
de onda. Para el ejemplo de este manual serán los resultados a dos 
longitudes de onda: WL530 y WL550, la columna de resultados 
será adicionada a esta tabla una vez adquiridos los datos por el 
espectrofotómetro. Los ID (números de identificación de cada 
estándar) y valores de concentración pueden ser adicionados creando 
la Standard table.

A.	De clic en cualquier lugar del panel de Standard Table de la 
pantalla.
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Figura 36. Esquema de ventanas para inicio de adquisición en modo 
                  cuantitativo UV-Probe. 

Fuente. Shimadzu U.-P. , 2014.

B.	Ingrese la siguiente información en las columnas Sample ID y 
Conc haciendo clic en cada casilla de la tabla con los valores de 
concentración de la siguiente tabla de ejemplo:

Tabla 2. Tabla ejemplo de concentraciones patrón para construcción curva de 
               calibración y ventana de estándares en UVProbe.
 

Sample ID Concentration

DyeA 0.0

DyeB 25.0

DyeC 50.0

DyeD 75.0

DyeE 100.0
 

Standard Table-(Active)
Sam-

ple ID Type Ex Conc WL
530,0

WL
550,0 Result Wgt.

Factor Comm

1* DyeA 0.000 1.000

2 DyeB 25.000 1.000

3 DyeC 50.000 1.000

4 DyeD 75.000 1.000

5 DyeE 100.000 1.000

6

Fuente. Shimadzu U.-P. , 2014.
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3.3.5 Lectura de los estándares

El espectrofotómetro puede ser usado para medir cada estándar. 
Sin embargo, UVProbe también puede ser usado para realizar la 
adquisición de datos para crear la curva.

Figura 37. Barra inferior de acciones en UVProbe..

 

Fuente. Shimadzu U.-P. , 2014.

A.	Verifique que el espectrofotómetro está conectado a su PC, en la barra 
de herramientas inferior. Si está conectado los botes los observará 
activos y el último ícono de la derecha será Disconnect (imagen 
arriba). Si no, haga clic en Connect en la barra de herramientas 
inferior.

B.	Diligencia la celda de cuarzo con el primer estándar y ubíquela en 
el compartimiento inferior (muestra). Cierre la tapa superior para 
iniciar la lectura.

Figura 38. Compartimiento para ubicación de muestreas en UV 1800.

Fuente. Adaptada de https://article.wn.com/view/2016/09/30/FY2015_
Slavery_and_Human_Trafficking_Statement_Shimadzu_Corp/



42
Aplicaciones y generalidades de un espectrofotómetro 

UV-VIS UV-1800 de shimadzu

C.	Dé clic en el ícono Read Std o presione la tecla F9. 
D.	El resultado aparecerá en el panel de Stardard table, en las columnas 

de WL530 y WL550 o en las columnas de las longitudes de onda 
que haya seleccionado para el análisis. 

E.	Continúe la lectura en el espectrofotómetro de la misma forma, en 
orden para cada estándar, no olvide purgar la celda con la siguiente 
solución más concentrada antes de dejar la solución para lectura. 

F.	 Los datos de absorbancia pueden ser ingresados manualmente si en 
la ventana de creación del método cambia a entrada manual. 

Figura 39. Ventana configuración de adquisiciones para estándar en modo 
cuantitativo UVProbe.

Fuente. Shimadzu U.-P. , 2014. 

G.	En la barra de herramientas superior seleccione View < Standard 
Curve para observar los datos adquiridos en la gráfica.
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Figura 40. Menú emergente para visualizar de la barra de herramientas 
                  principal de UVProbe.

Fuente. Shimadzu U.-P. , 2014. 

H.	A medida que se realizan las lecturas de cada estándar comenzará 
a visualizar el resultado en la tabla y en la gráfica, como se observa 
en la imagen abajo.

Figura 41. Esquema de ventanas durante adquisición del primer estándar en 
                  modo cuantitativo UVProbe.
 

Fuente. Shimadzu U.-P. , 2014

I.	 Una vez termina la adquisición de los estándares obtendrá la tabla 
completa y la gráfica. 
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Figura 42. Esquema de ventanas durante adquisición de los tres primeros 
                   estándares en modo cuantitativo UVProbe.
 

Fuente. Shimadzu U.-P. , 2014

J.	 Para visualizar los parámetros estadísticos de la curva dé clic 
derecho con el mouse y seleccione Propiedades para obtener la 
ventana emergente Standard Curve Properties. 

Figura 43. Ventana para configuración de estadísticas de las adquisiciones en 
                   modo cuantitativo UBProbe. 

Fuente. Shimadzu U.-P. , 2014.

K.	 Seleccione los parámetros estadísticos que desea visualizar dando 
clic en los recuadros.

L.	 Dé clic en X para cerrar.
M.	Para cambiar el orden de la curva seleccione Edit > Method. 

Seleccione la pestaña Calibration en la ventana emergente y en el 
campo de Order for Curve seleccione 2.° o 3.° orden en busca del 
mejor ajuste matemático a los datos adquiridos.
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3.3.6 Guardar resultados tabla de estándares

La tabla de estándares que acaba de crear puede ser almacenada para 
consultarla posteriormente.

A.	De la barra superior seleccione File > Save As. Verifique que la 
carpeta de destino sea el directorio Data (imagen) en el campo 
Guardar en.

B.	 Ingrese el nombre del archivo, por ejemplo: Standardd1 en el 
campo Nombre. 

C.	En el campo Tipo seleccione *.std.
D.	Dé clic en Guardar.

Figura 44. Ventana para almacenamiento en disco de los resultados adquiridos 
                  en modo cuantitativo UVProbe.

Fuente. Shimadzu U.-P. , 2014. 

3.3.7 Medición muestra desconocida

Para este momento se puede estimar la concentración de muestras 
desconocidas empleando la curva de calibración que se obtuvo. De 
la misma forma en que fue creada la tabla de estándares en el panel 
superior izquierdo de la pantalla, se realiza la creación de la tabla de 
muestras en el panel inferior izquierdo (Sample table). 
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A.	Dé clic en cualquier lugar del panel Sample table, en la parte 
superior aparecerá el mensaje Active, como se observa en la imagen.

Tabla 3. Tabla de muestras en modo cuantitativo UVProbe.

Fuente. Shimadzu U.-P. , 2014. 

B.	Digite los ID de las muestras a analizar (desconocidas), para 
incluir una nueva casilla dé Enter. Para el ejemplo de este manual 
digitaremos DyeF, DyeG, DyeH, DyeI, DyeJ. Se obtendrá el panel, 
como se muestra en la imagen.

Tabla 4. Tabla de muestras diligenciada en modo cuantitativo UVProbe.
Standard Table-(Active)

Sam-
ple ID Type Ex Conc WL

530,0
WL

550,0 Result Comments

1* DyeF

2 DyeG

3 DyeH

4 DyeI

5 DyeJ

 Fuente. Shimadzu U.-P. , 2014. 

C.	Si no observa en la pantalla el panel de grafica de la muestra (Sample 
Curve), seleccione View de la barra de herramientas superior y 
simple Curve del menú desplegable (imagen a la derecha). En este 
panel podrá observar la concentración calculada desde la curva de 
calibración de sus muestras gráficamente.

D.	Ahora puede iniciar la lectura de las soluciones desconocidas 
desde el espectrofotómetro o de igual forma que en la curva de 
calibración puede ingresar los datos manualmente en la tabla. 
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Figura 45. Barra inferior de acceso rápido a procesos UVProbe.

 

Fuente. Shimadzu U.-P. , 2014. 

E.	Verifique que el espectrofotómetro está conectado a su PC en la barra 
de herramientas inferior. Si está conectado los botes los observará 
activos y el último ícono de la derecha será Disconnect (imagen 
arriba). Si no, haga clic en Connect, en la barra de herramientas 
inferior.

F.	 Diligencie la celda de cuarzo con el primer estándar, ubíquela en 
el compartimiento inferior (muestra). Cierre la tapa superior para 
iniciar la lectura.

G.	Dé clic en el ícono Read Std o presione la tecla F9. 

Figura 46. Imagen de compartimientos para muestras UV-1800.

Fuente. Adaptada de https://article.wn.com/view/2016/09/30/FY2015_
Slavery_and_Human_Trafficking_Statement_Shimadzu_Corp/

H.	El resultado aparecerá en el panel de Stardard table en las columnas 
de WL530 y WL550, o en las columnas de las longitudes de onda 
que haya seleccionado para el análisis.
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Figura 47. Menú emergente para ver de la barra de herramientas principal UV 
                  Probe. Graficar muestra en modo fotométrico.

Fuente. Shimadzu U.-P. , 2014

I.	 Continúe la lectura en el espectrofotómetro, de la misma forma en 
orden para cada estándar, no olvide purgar la celda con la siguiente 
solución más concentrada antes de dejar la solución para lectura. 

Figura 48. Muestras en modo cuantitativo UVProbe terminada la adquisición.
 

Fuente. Shimadzu U.-P. , 2014. 

3.3.8 Guardar información del análisis

La información de las tablas de los estándares y de las muestras 
puede ser almacenada en el disco en este momento. Los archivos 
Photometric contienen las dos informaciones, tanto la información 
de los estándares como de las muestras.

A.  Seleccione File > Save.
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3.4  Generación de reportes para impresión
3.4.1 Creación de formatos personalizados

El generador de reportes es una herramienta para dar formato a los 
resultados adquiridos, el usuario puede crear, dar formato, guardar 
e imprimir sus reportes, los cuales incluyen gráficas, texto, objetos 
insertados. Cuenta con un enlace a los diferentes módulos de UVProbe.

A.	Para iniciar el módulo de reportes es importante tener en UVProbe 
abierto el archivo de resultados o método que desea formatear en 
un reporte.

B.	En la barra superior seleccione el ícono 

Figura 49. Barra de herramientas principal en modo fotométrico.
 

Fuente. Shimadzu U.-P. , 2014

Obtendrá la ventana del generador de reportes (imagen abajo).

Figura 50. Ventana para edición y preparación de reportes de adquisición en 
                  UVProbe.
 

Fuente. Adaptado de Shimadzu U.-P. , 2014.
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C.	Configure la página de su reporte, inicie configurando las márgenes, 
en la barra de herramientas superior File < Page Setup. 

D.	Inmediatamente obtendrá la ventana emergente para configurar la 
página.

Figura 51. Ventanas de configuración para reportes en UVProbe.

Fuente. Shimadzu U.-P. , 2014. 

E.	En los campos izquierdo, derecho, superior e inferior digite las 
márgenes de su preferencia, por ejemplo 10.

F.	 Con la barra de herramientas izquierda, de acuerdo al método 
usando para el análisis (Photometric o Spectrum), puede insertar 
la información por grupos para ajustar el formato. A continuación 
un ejemplo.

G.	Para la curva de calibración creada con el método Photometric 
iniciaremos con el gráfico de la curva.

H.	Seleccione el ícono        que mostrará como recuadro blanco 
el espacio que ocupa el gráfico dentro del formato de reporte, el 
usuario debe, con la ayuda del mouse, ubicar la localización de este 
ítem.
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Figura 52. Configuración de reporte UVProbe.

Fuente. Shimadzu U.-P. , 2014. 

I.	 Para visualizar el reporte dé clic en el ícono de la barra de 
herramientas superior. Inmediatamente tendrá una vista preliminar 
de su reporte, como lo muestra la imagen.

Figura 53. Vista previa reporte en UBProbe.

 

Fuente. Shimadzu U.-P. , 2014. 

 De esta forma el usuario continúa insertando los reportes del análisis 
que considere necesarios.
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3.4.2 Generación de reportes usando plantillas 	      	     
         predeterminadas

El software UVProbe cuenta con plantillas estándar para la presentación 
de reportes para ello siga el procedimiento básico que se describe a 
continuación:

a.	 Desde la barra de herramientas seleccione File < Open. Inmedia-
tamente visualizará en la ventana emergente (Abrir) el listado de 
plantillas disponibles. Seleccione la que desea usar teniendo en 
cuenta el método de análisis y la información que desea presentar 
en el reporte.

Figura 54. Ventana para abrir plantillas de reportes en UVProbe.

Fuente. Shimadzu U.-P. , 2014. 

b.	 Dé clic en el ícono Abrir. Observará en pantalla los recuadros que 
muestran el espacio de ocupación de cada campo. Para visualizar 
una vista preliminar de su reporte dé clic en el ícono de la barra de 
herramientas superior.
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Figura 55. Esquema de ventanas de plantillas y vistas previas UBProbe.

Fuente. Shimadzu U.-P. , 2014. 
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4.
La espectroscopia UV-VIS como técnica analítica ha estado en uso 

durante los últimos 35 años, durante este periodo se ha convertido 
en uno de los instrumentos analíticos en el día a día. En muchas 
aplicaciones se podrían emplear otras técnicas, pero ninguna compite 
con el UV-VIS por su simplicidad, versatilidad, velocidad, precisión 
y rentabilidad. Cuando consultamos el banco de información del 
Analytical Abstracts, encontramos alrededor de 40.000 coincidencias 
relacionadas con espectrofotometría UV-VIS. Los procedimientos 
involucran medidas directas de las especies que absorben la radiación, 
medidas derivadas por acoplamiento con diversas técnicas o procesos, 
como cromatografía, electroforesis u otros análisis de flujo.

Identificar la identidad de una sustancia, así como las sustancias 
están presentes en una mezcla es llamado análisis cualitativo, mientras 
que analizar la cantidad de estas sustancias en la mezcla es llamado 
análisis cuantitativo, ambos tipos de análisis son posibles en el equipo 
UV-1800.

4.1   Análisis cualitativo (espectro y
       estructura química)

La absorbancia de luz en la zona del UV-VIS es determinada por un 
cromóforo (grupo funcional que absorbe luz como C=O, C=C, N=N, 
y N=O, que tienen múltiples enlaces) y un auxocromo (como –OH, 

Aplicación 
espectroscopia 
UV-VIS
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-NH2, y –SH, con pares de electrones no enlazantes) de manera que 
depende de la estructura química de cada analito que mostrará un 
patrón específico en el espectro de absorción (es decir, la gráfica de la 
intensidad de absorción frente a la longitud de onda de la radiación 
incidente).

Para las longitudes de onda en el rango UV-VIS, podríamos esperar 
que el espectro de absorción de una molécula mostrara líneas agudas, 
ya que a una longitud de onda con la energía que coincide exactamente 
a la requerida para excitar un electrón hacia una transición electrónica 
es la única capaz de registrar absorción. No obstante, en la práctica 
se encuentra que el espectro UV-VIS de la mayoría de las moléculas 
consiste en unas cuantas curvas ensanchadas en vez de líneas agudas.

Figura 56. Espectro UV para el tolueno adquirido en UV-1800.

 

Fuente. http://www.shimadzu.com.br/analitica/produtos/spectro/uv/
uv-1800.shtml

Estas curvas nos muestran que la molécula está absorbiendo 
radiación sobre un rango de longitudes de onda, en razón a que la 
transición electrónica suele ir acompañada de un cambio simultáneo 
entre numerosos niveles vibratorios asociados, así como con un gran 
número de rotaciones. De esta manera, una transición consiste de un 
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componente electrónico, un elemento vibratorio más pequeño y un 
componente de rotación aún más pequeño. Esta última transición, la 
contribución rotacional, muestra su resultado en la banda ensanchada 
por su efecto de rellenar los vacíos (absorción en amplios rangos de 
longitud de onda).

En la transición de electrones de orbitales de estado fundamental 
tenemos tres tipos de orbitales que pueden estar relacionados: orbitales 
híbridos ∏ (enlaces sencillos), orbitales híbridos ∏ (enlaces dobles) n 
(no enlazantes) y los orbitales del estado excitado σ * y ∏ *.

Una transición en la que un electrón de unión se excita a un orbital 
σ antienlazado se denomina transición de σ a σ *. En el mismo orden 
∏ a ∏ * representa la transición de un electrón. Así, las siguientes 
transiciones electrónicas pueden ocurrir por la absorción de la luz 
ultravioleta y visible:

σ a σ *,
n a σ *
n a ∏ *
∏ a ∏ *.

La figura 56 ilustra el patrón general de los niveles de energía, y 
el hecho de que las transiciones son provocadas por la absorción de 
diferentes cantidades de energía.

4.1.1 Compuestos saturados

Las transiciones σ a σ * y n a σ * requieren una gran cantidad 
de energía, por lo tanto ocurren en la región ultravioleta lejano o 
débilmente en la región 180-240nm. En consecuencia, los grupos 
saturados no exhiben una fuerte absorción en la región ultravioleta. 
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Las transiciones a orbitales ∏ * que ocurren en la región 
ultravioleta para una molécula saturada particular, tienen lugar 
en la región visible si se modifica la estructura molecular. Muchos 
compuestos inorgánicos en solución también muestran absorción en 
la región visible. Estas incluyen sales de elementos con capas internas 
incompletas de electrones (principalmente metales de transición), 
cuyos iones están complejados por hidratación, por ejemplo, [Cu 
(H2O4 )]

2+. Tales absorciones surgen de un proceso de transferencia de 
carga, donde los electrones se mueven de una parte del sistema a otro 
por la energía proporcionada por la luz visible.

4.1.2 Compuestos poliinsaturados, o dobles enlaces 
         conjugados (cromóforos)

Las transiciones de ∏ a ∏ *, cuando ocurren en grupos aislados en 
una molécula, dan lugar a una absorción de luz bastante baja. Sin 
embargo, la conjugación de grupos insaturados en una molécula 
produce un efecto notable sobre el espectro de absorción. La longitud 
de onda de la absorción máxima se mueve a una longitud de onda 
más larga y la intensidad de absorción a menudo puede aumentar. Los 
sistemas aromáticos, que contienen electrones en orbitales p, absorben 
fuertemente en el ultravioleta.

En general, cuanto mayor es la longitud de un sistema conjugado 
en una molécula, más cerca está el λ max de la región visible. Así, la 
energía característica de una transición y, por lo tanto, la longitud 
de onda de absorción, es una propiedad de un grupo de átomos más 
bien que los electrones mismos. De esta forma es posible identificar 
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el grupo cromóforo presente en un analito basado en el análisis del 
espectro de absorción (tabla ε máx).

Tabla 5. Absorciones de los principales grupos cromóforos UV-VIS.

Cromóforo Solvente λmax 
(nm) ε máx Tipo de 

transición

Alqueno n-Heptano 177 13000
                   

π-π*

Alquino n-Heptano
178
196
225

10000
2000
160

π-π*

Carbonilo (Cetona) n-Heptano
186
280

1000
16

n-σ*
n-π*

Carbonilo (Aldehido) n-Heptano
180
293

Elevada
12

n-σ*
n-π*

Carboxilo n-Heptano 204 41 n-π*

C-X Hexano
205
255

200
360

n-σ*

-OH Agua 180 316 n-σ*

Amida Agua 214 60 n-π*

Azo Etanol 339 5 n-π*

Nitro Isooctanol 280 22 n-π*

Nitroso Etileter
300
665

100
20

n-π*

Nitrato Dioxano 270 12 n-π*

Fuente. Elaborada a partir de Kumar (2006) y Jang (2017). 

Es importante anotar la importancia del solvente sobre el 
espectro resultante, ya que la absorbancia en intensidad y longitud 
de onda puede cambiar con la introducción de solventes o diferentes 
compuestos en una mezcla. Estos cambios pueden generan cuatro 
efectos diferentes: el cambio del pico de absorbancia hacia longitudes 
de onda más grandes es llamado movimiento batocrómico”; el cambio 
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hacia a longitudes de onda más pequeños es llamado “movimiento 
hipsocrómico”; la disminución en la intensidad de la absorbancia 
se conoce como “movimiento hipocrómico”; el aumento se conoce 
como “movimiento hipocrómico”.

Tabla 6. Disolventes comúnmente utilizados y sus longitudes de onda de 
              máxima absorción.

Solvente Cut-off  (nm)

Iso-octano 202

Alcohol etílico 205

Ciclohexano 200

Acetona 325

Tetracloroetileno 290

Benceno 280

Tetracloruro de carbono 265

Cloroformo 245

Éter etílico 220

Alcohol isopropílico 210

Alcohol metílico 210

Fuente. Elaborada a partir de Kumar (2006) y Jang (2017).

4.2 Análisis cuantitativo (curvas de 
      calibración)

El equipo UV-1800 tiene su mayor aplicación en el análisis cuantitativo 
de analitos o también conocido como análisis colorimétricos. La ley 
que es principio de este análisis cuantitativo es la ley de Lambert-Beer, 
que tiene su base matemática en la medida de absorción de radiación 
de muestras en solución.
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Figura 57. Esquema paso de luz a través de la muestra en la celda.

 

Fuente. Elaboración propia. 

En términos de absorbancia, la expresión matemática es A= 
log(Io/I) =k x c x l. Donde A es absorbancia, Io es la intensidad de la 
radiación monocromática que incide en la muestra e I la intensidad 
de la radiación que emerge de la muestra. 

La absorbancia (A) es una característica específica que depende de 
la intensidad incidente, la longitud del paso óptico y la concentración 
del analito. Cuando tomamos la longitud del paso óptico como 1cm 
y la concentración como 1mol/L, obtenemos la constante ε, que se 
conoce como coeficiente de absortividad molar un valor único y 
específico de cada compuesto bajo condiciones específicas (Io, c y l).

El método cuantitativo para medir la concentración de una muestra 
de concentración desconocida desde la absorción de una muestra de 
concentración conocida puede ser realizada usando los siguientes dos 
métodos:

w Curva de calibración
w Adición de estándar

En el método de la curva de calibración se preparan estándares 
de concentración conocida, a los cuales se les realiza la medición 
de absorbancia. Una curva de calibración es construida usando la 
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absorbancia obtenida en el eje vertical y la concentración de los 
estándares en el eje horizontal, cuando el resultado no muestra 
una relación lineal comúnmente es por la presencia de partículas 
en suspensión que actúan como cuerpos oscuros y desvían el 
comportamiento descrito por la ley de Lambert Beer. Cuando se usa 
una solución blanca la curva de calibración debe pasar por el origen, 
no obstante, si un blanco no es medido, es posible que la curva no 
pase por el origen, para la determinación de la concentración de las 
muestras desconocidas los resultados se obtienen por interpolación 
desde la curva de calibración.

En el método de adición de estándar, a una muestra estándar es 
adicionada por etapas a cuatro o más muestras de la muestra a medir. 
De manera similar al método de la curva de calibración una relación 
matemática entre la absorbancia y la concentración es construida. La 
concentración del componente objetivo en la muestra desconocida es 
extraída de la gráfica tomando el punto de corte de la curva con el 
eje vertical (Y). Este método es aplicado solamente cuando se tienen 
rangos bajos de concentración.

Figura 58. Curva de calibración ejemplo en el método de adición de estándar.

 

Fuente. Elaboración propia. 
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Una curva de calibración es generalmente recta, sin embargo, puede 
curvase debido a varias razones: 

w	 Un daño en el circuito de medida.
w	 Fluorescencia en la muestra.
w	 Linealidad de la luz incidente.
w	 Amplitud de la banda. 
w	 Determinación de la cuantificación, no en un pico de absorción 

sino en un hombro de la banda.

Primero, de manera inherente a cada equipo existe la deriva 
inmediatamente y es encendido el equipo, por ello es aconsejable 
iniciar las mediciones 30 minutos después de encender el equipo para 
evitar este tipo de desviaciones.

 
Segundo, cuando una muestra emite luz fluorescente y esta llega 

al detector, la absorbancia puede parecer menor y la cantidad de 
fluorescencia incrementa con la concentración de la muestra. Como 
resultado, la curva de calibración puede curvarse hacia el extremo 
inferior. Si esto ocurre, es necesario reducir la influencia de la luz 
fluorescente tanto como sea posible, incrementando la distancia entre 
la muestra y el detector o insertando un enmascarante entre la muestra 
y el detector.

Tercero, la luz lineal es el total de la luz de una longitud de onda 
desviada desde un cierto espectro, con una configuración específica 
del monocromador, y la emitida desde este, pero la luz que no es 
transmitida desde la fuente hacia la muestra pasa por un lado de 
la muestra y genera un error en la medición, para la corrección de 
este error que toma importancia en muestras con altos valores de 
absorbancia > 0,8, puede usar la siguiente tabla. Tabla tomada del 
manual UV-1800. Para minimizar este error se sugiere la instalación 
de un doble monocromador.
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Tabla 7. % pérdida de luz incidente.
% Pérdida 

de luz
Absorbancia

0.8 1.0 1.2 1.5 1.8 2.0 2b.5 3.0 4.0

1 0.0222 0.0370 0.0595 0.1150 0.2081 0.2967 0.6150 1.0370 2.0000

0.5 0.0133 0.0190 0.0309 0.0615 0.1169 0.1739 0.4096 0.7759 1.7059

0.2 0.0045 0.0077 0.0126 0.0257 0.0507 0.0783 0.2119 0.4762 1.3213

0.1 0.0022 0.0038 0.0063 0.0130 0.0261 0.0409 0.1188 0.3005 1.0409

0.05 0.0011 0.0019 0.0032 0.0065 0.0132 0.0209 0.0635 0.1758 0.7799

0.02 0.0004 0.0007 0.0012 0.0026 0.0053 0.0085 0.0365 0.0790 0.4770

0.01 0.0002 0.0003 0.0006 0.0013 0.0026 0.0042 0.0134 0.0413 0.3009

0.005 0.0001 0.0001 0.0003 0.0006 0.0013 0.0021 0.0067 0.0211 0.1791

0.002 0.0000 0.0000 0.0001 0.0003 0.0005 0.0008 0.0027 0.0085 0.0791

0.0011 0.0000 0.0000 0.0000 0.0001 0.0002 0.0004 0.0013 0.0043 0.0413

0.0001 0.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.0001 0.0004 0.0043

Fuente. Tomado de SHIMATDZU.UV-Prove, 2013.

Cuarto, una lámpara de halógeno o una lámpara de deuterio es 
usada como fuente de luz del espectrómetro, en razón a que estas 
lámparas emiten un espectro continuo, es un aspecto que toma 
importancia en razón que el coeficiente de absortividad difiere con 
pequeños cambios en la longitud de onda, de esta forma el ancho de 
banda de medición influye en el valor del coeficiente de absortividad 
entre mayor es el ancho mayor variación se introduce en la medición, 
para minimizar el efecto es suficiente con configurar un ancho de 
banda de 1/8 a 1/10 de la mitad de la banda de absorbancia.
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